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XP Objec;ves	
  

•  Understand the use of spreadsheets and Excel	
  
•  Learn the parts of the Excel window	
  
•  Scroll through a worksheet and navigate	
  

	
  between worksheets	
  
•  Create and save a workbook file	
  
•  Enter, analyze, and present quanAtaAve data	
  
•  Enter text, numbers, and dates into a	
  

	
  worksheet	
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XP Objec;ves	
  

• 
• 
• 
• 
• 
• 
• 
• 

Resize, insert, and remove columns and rows	
  
Select and move cell ranges	
  
Insert formulas and funcAons	
  
Insert, delete, move, and rename worksheets	
  
Work with ediAng tools	
  
Format data using paGerned text and flash fill	
  
Insert and format custom borders	
  
Preview and print a workbook	
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XP Visual Overview	
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XP The Excel Window	
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XP Introducing Microso> Excel 2013	
  
•  Computer program used to enter, store, analyze,	
  

	
  and present quanAtaAve data in an organized and	
  
	
  easily updatable manner	
  

•  Creates electronic versions of spreadsheets	
  
	
   	
  –CollecAon of text and numbers laid out in a grid	
  

•  Displays values calculated from data	
  
•  Represents data in both text and graphical from	
  

	
  through the use of charts	
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Microso> Excel 2013 (Con;nued) XP 

•  Allows what-­‐if analysis	
  
	
   	
  –Ability to change values in a spreadsheet and	
  
	
   	
   	
  assess the effect they have on calculated values	
  
	
   	
   	
  automaAcally	
  

•  Automates many tasks through the use of	
  
	
  formulas including both automaAc formulas and	
  
	
  custom formulas	
  

•  A Quick Analysis tool allowing conversion from	
  
	
  data to charts in two easy steps	
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Microso> Excel 2013 (Con;nued) XP 

•  Integrates data from several spreadsheets within	
  
	
  a single workbook, and also interfaces with other	
  
	
  workbooks when data from mulAple sources is	
  
	
  required	
  

•  Templates already available for budgets,	
  
	
  calendars, forms, and reports	
  

•  A new Flash Fill feature allows you to have data	
  
	
  automaAcally entered based on iniAal data you	
  
	
  enter	
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Microso> Excel 2013 (Con;nued) XP 

•  Excel 2013 offers a Chart RecommendaAon	
  
	
  feature suggesAng the best chart to fit your data	
  
	
  needs	
  

•  Excel also increased filtering funcAonality adding	
  
	
  an interacAve way to easily filter data in query	
  
	
  tables and Excel data tables	
  

•  Excel 2013 adds a One Workbook, One Table	
  
	
  feature allowing you to view mulAple workbooks	
  
	
  simultaneously	
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Microso> Excel 2013 (Con;nued) XP 

•  Excel 2013 includes addiAonal funcAons in several	
  
	
  areas including basic math, trigonometry,	
  
	
  staAsAcs, look-­‐up, and text funcAons	
  

•  New chart features include addiAons to the chart	
  
	
  ribbon, richer data labeling, and adds animaAon	
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XP Spreadsheet Data in Excel	
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XP Worksheet Naviga;on	
  
•  A workbook can have two kinds of sheets:	
  

	
  –Worksheet contains a grid of rows and	
  
	
   	
  columns into which user enters data	
  
	
  –Chart sheet provides visual representaAon	
  
	
   	
  of data	
  

•  Cell reference idenAfies column/row locaAon	
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XP Worksheet Naviga;on	
  
•  To navigate between worksheets	
  

	
  –Use sheet tabs	
  
•  To navigate within a worksheet	
  

	
  –Use mouse, keyboard, GoTo dialog box, or	
  
	
   	
  type cell reference in Name box	
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XP Worksheet Naviga;on Keys	
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XP Planning a Workbook	
  
•  Use a planning analysis sheet to define:	
  

	
  –Goal or purpose of workbook	
  
	
  –Type of data to collect	
  
	
  –Formulas needed to apply to data you	
  
	
   	
  collected and entered	
  
	
  –Appearance of workbook content	
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XP Crea;ng a New Work Book	
  

•  You create new workbooks from the New	
  
	
  screen in Backstage view from the Blank	
  
	
  workbook template	
  
	
   	
  – On the ribbon, click the File tab to display	
  
	
   	
   	
  Backstage view.	
  
	
   	
  – Click New in the navigaAon bar to display the New	
  
	
   	
   	
  screen	
  

	
   	
  – Click the Blank workbook Ale.	
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XP Working with Worksheets	
  

•  InserAng a worksheet	
  
	
  –Name of new worksheet is based on number	
  
	
   	
  and names of other sheets in the workbook	
  

•  DeleAng a worksheet	
  
•  Renaming a worksheet	
  

	
  –31 characters maximum, including blank	
  
	
   	
  spaces	
  
	
  –Width of sheet tab adjusts to length of name	
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XP 
	
  Working with Worksheets	
  
	
  •  Moving and copying a worksheet	
  
	
   	
  –To move:	
  

	
   	
   	
   	
  • Click and drag	
  
	
   	
  –To copy:	
  
	
   	
   	
   	
  • Ctrl + drag and drop	
  
	
   	
  –Place most important worksheets at	
  
	
   	
   	
  beginning of workbook (le`most sheet	
  
	
   	
   	
  tabs), less important worksheets toward	
  
	
   	
   	
  end (rightmost tabs)	
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XP Entering Text, Numbers, and Dates	
  
•   Text data	
  

	
  – CombinaAon of leGers, numbers, and symbols	
  

	
  – O`en referred to as a text string	
  
•   Number data	
  

	
  – Numerical value to be used in a mathemaAcal	
  
	
   	
  calculaAon	
  

•   Date and ;me data	
  
	
  – Commonly recognized formats for date and Ame	
  
	
   	
  values	
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XP Entering Text	
  
•  New data appears in both the acAve cell and	
  

	
  the formula bar	
  
•  TruncaAon	
  
•  AutoComplete feature	
  
•  To enter mulAple lines of text within a cell	
  

	
   	
  –Create a line break with Alt + Enter	
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XP Entering Text	
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XP Entering Numbers	
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XP Edi;ng Cell Content	
  
•   As you work, you might find entries you need	
  

	
  to change or correct.	
  
	
  – If you want to replace all of the content in a cell,	
  
	
   	
  you simply select the cell and then type the new	
  
	
   	
  entry to overwrite the previous entry.	
  
	
  – If you need to replace only part of a cell’s content,	
  
	
   	
  you can work in Edit mode.	
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Edi;ng Cell Content in Edit Mode  XP 

•   Edit Mode	
  
– Double-­‐click the cell to select the cell and switch to	
  
Edit mode	
  

• A blinking inserAon point appears within the text of cell	
  

– Press the arrow keys to move the inserAon point	
  
to the right of the word being edited	
  

– Press the Backspace key three Ames to delete the	
  
word being edited	
  

– Type & to enter the new text, and then press the	
  
Enter key	
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XP Edi;ng Worksheet Content	
  
•   Use Edit mode to edit cell contents	
  

	
  – Keyboard shortcuts apply only to text within	
  
	
   	
  selected cell	
  

	
  •   Undoing and redoing an acAon	
  
	
   	
  – Excel maintains a list of acAons performed in a	
  
	
   	
   	
  workbook during current session	
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XP Edi;ng Worksheet Content	
  
•  Number displayed as text	
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XP Entering Numbers	
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Working with Columns and Rows  XP 

•  To make data easier to read:	
  
	
  –Modify size of columns and rows in a	
  
	
   	
  worksheet	
  

•  To modify size of columns or rows:	
  
	
  –Drag border to resize	
  
	
  –Double-­‐click border to autofit	
  
	
  –Format the Cells group to specify	
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Working with Columns and Rows  XP 

•  Column width	
  
–Expressed in terms of number of characters	
  
or pixels (8.43 characters equals 64 pixels)	
  

–Note: Pixel size is based on screen	
  
resoluAon	
  

•  Row height	
  
–Measured in points (1/72 of an inch) or	
  
pixels	
  

–Default row height: 15 points or 20 pixels	
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Working with Columns and Rows  XP 
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Working with Columns and Rows  XP 

•  Resizing columns and rows with AutoFit	
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Working with Columns and Rows  XP 

•  DeleAng and clearing a row or column	
  
	
  –DeleAng removes both the data and the	
  
	
   	
  cells	
  
	
  –Clearing removes the data, leaving blank	
  
	
   	
  cells where data had been	
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XP Wrapping Text Within a Cell	
  

	
  •  Wrapping text enables text to display on two	
  
	
   	
  or more rows within one cell allowing more	
  
	
   	
  text within a narrower column.	
  
	
   	
   	
  – Resize the width of column as appropriate.	
  
	
   	
   	
  – Select the cells you wish to apply wrapping to	
  
	
   	
   	
  – On the Home tab, in the Alignment group, click the	
  
	
   	
   	
   	
  Wrap Text buGon.	
  
	
   	
   	
   	
   	
  • The Wrap Text buGon is toggled on, and text in the	
  
	
   	
   	
   	
   	
   	
  selected cells that exceeds the column width wraps to a	
  
	
   	
   	
   	
   	
   	
  new line.	
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XP Working with Cells and Ranges	
  

	
  •  Range reference indicates locaAon and size of	
  
	
   	
  a cell range	
  
	
   	
   	
  –Adjacent (A1:G5)	
  
	
   	
   	
  –Nonadjacent (A1:A5;F1:G5)	
  
	
  •  SelecAng a range	
  
	
   	
   	
  –Work with all cells in the range as a group	
  
	
  •  Moving and copying a range	
  
	
   	
   	
  –Drag and drop	
  
	
   	
   	
  –Cut and paste	
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XP Working with Cells and Ranges	
  
•  InserAng and deleAng a range	
  

	
  –ExisAng cells shi` to accommodate the	
  
	
   	
  change	
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XP Moving a cell or a Range of Cells	
  

•  Select the cell or range you want to move or	
  
	
  copy	
  

•  Move the pointer over the border of the	
  
	
  selecAon unAl the pointer changes shape	
  

•  To move the range, click the border and drag	
  
	
  the selecAon to a new locaAon	
  
	
   	
  – Or to copy the range, hold down the Ctrl key and	
  
	
   	
   	
  drag the selecAon to a new locaAon	
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XP Copying a Cell or Range of Cells	
  

•  Select the cell or range you want to move or	
  
	
  copy	
  

•  On the Home tab, click the Cut or Copy buGon	
  
	
   	
  – Or right-­‐click the selecAon, and then click Cut or	
  
	
   	
   	
  Copy on the shortcut menu	
  

•  Select the cell or the upper-­‐le` cell of the	
  
	
  range where you want to paste the content	
  

•  Click the Paste buGon	
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XP Visual Overview	
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XP Worksheet Data	
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XP Working with Formulas	
  
•   Formula	
  

	
  – An expression that returns a value	
  
	
  – WriGen using operators that combine different	
  
	
   	
  values, resulAng in a single displayed value	
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XP Working with Formulas	
  

	
  •  Entering a formula	
  
	
   	
  –Click cell where you want formula results to	
  
	
   	
   	
  appear	
  
	
   	
  –Type = and an expression that calculates a	
  
	
   	
   	
  value using cell references and arithmeAc	
  
	
   	
   	
  operators	
  
	
   	
   	
   	
  • Cell references allow you to change values	
  
	
   	
   	
   	
   	
  used in the calculaAon without having to	
  
	
   	
   	
   	
   	
  modify the formula itself	
  
	
   	
  –Press Enter or Tab to complete the formula	
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XP Working with Formulas	
  

•  Order of precedence	
  
	
  –Set of predefined rules used to determine	
  
	
   	
  sequence in which operators are applied in	
  
	
   	
  a calculaAon	
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XP Working with Formulas	
  

•   Viewing a formula	
  
	
  – Select cell and review expression displayed in the	
  
	
   	
  formula bar	
  
	
  – Each cell reference is color coded in the formula	
  
	
   	
  and corresponding cell in the worksheet	
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XP Working with Formulas	
  
•  Copying and pasAng formulas	
  

	
  –Cell references adjust to reflect new	
  
	
   	
  locaAon of the formula in the worksheet	
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XP Working with Formulas	
  
•  Guidelines for wriAng effecAve formulas:	
  

	
  –Keep them simple	
  

	
  –Do not hide data values within formulas	
  

	
  –Break up formulas to show intermediate	
  
	
   	
  results	
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XP Introducing Func;ons	
  

	
  •   Func;on	
  
	
   	
  – Named operaAon that returns a value	
  
	
   	
  – Simplifies a formula, reducing a long formula into a	
  
	
   	
   	
  compact statement; for example, to add values in	
  
	
   	
   	
  the range A1:A10:	
  
	
   	
   	
   	
  • Enter the long formula:	
  
	
   	
   	
   	
   	
   	
  =A1+A2+A3+A4+A5+A6+A7+A8+A9+A10	
  
	
   	
   	
   	
   	
   	
   	
  -­‐ or -­‐	
  
	
   	
   	
   	
  • Use the SUM funcAon to accomplish the same	
  
	
   	
   	
   	
   	
  thing:	
  
	
   	
   	
   	
   	
   	
  =SUM(A1:A10)	
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Entering Func;ons with AutoSumXP 

•   Fast, convenient way to enter commonly used	
  
	
  funcAons	
  

•   Includes buGons to quickly insert/generate:	
  
	
   	
  – Sum of values in column or row (SUM)	
  

	
   	
  – Average value in column or row (AVERAGE)	
  
	
   	
  – Total count of numeric values in column or row	
  
	
   	
   	
  (COUNT)	
  

	
   	
  – Minimum value in column or row (MIN)	
  

	
   	
  – Maximum value in column or row (MAX)	
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Entering Func;ons with AutoSumXP 
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XP Previewing a Workbook	
  

•  Changing worksheet views	
  
	
  –Normal view	
  
	
  –Page Layout view	
  
	
  –Page Break Preview	
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XP Page Layout View	
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XP Page Break Preview	
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XP Previewing a Workbook	
  
•  Working with page orientaAon	
  

	
  –Portrait orienta;on (default)	
  
	
   	
  • Page is taller than wide	
  
	
  –Landscape orienta;on	
  
	
   	
  • Page is wider than tall	
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XP Prin;ng a Workbook	
  

	
  •  Print tab provides opAons for choosing what	
  
	
   	
  to print and how to print	
  
	
   	
   	
  –Printout includes only the data in the	
  
	
   	
   	
   	
  worksheet	
  
	
   	
   	
  –Other elements (e.g., row/column headings,	
  
	
   	
   	
   	
  gridlines) will not print by default	
  
	
  •  Good pracAce: Review print preview before	
  
	
   	
  prinAng to ensure that printout looks exactly	
  
	
   	
  as  you intended and avoid unnecessary	
  
	
   	
  reprinAng	
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XP Prin;ng a Workbook	
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XP Viewing and Prin;ng Worksheet	
  
Formulas	
  
•   Switch to formula view	
  

	
  – Useful when you encounter unexpected results	
  
	
   	
  and want to examine underlying formulas or to	
  
	
   	
  discuss your formulas with a colleague	
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XP Viewing and Prin;ng Worksheet	
  
Formulas	
  
•  Scaling the printout of a worksheet forces	
  

	
  contents to fit on a single page	
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